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ATTENTION! The detachable microphone must be used only with Tango_Plus! The cap-
sule MK255 and the preamplifier (Order number: 907144.5) are selected
as pair by manufacturer and must not be devided! If used with other hard-
ware with more than ± 2.5 V power supply, the preamplifier will be dama-
ged and warranty is lost!
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Preface
Thank you for choosing the product Tango_Plus by SINUS Messtechnik GmbH. Please read this manual
carefully before using the measuring system. We recommend you to perform several test measurements
to get familiar with the instrument before using it for important measuring tasks. The manual includes the
following signs to indicate important information:

NOTICE! These are information on the efficient use and correct handling of the ana-
lyzer as well as additional information.

CAUTION! These instructions shall avoid any hardware damages or dangers for users.

ATTENTION! These instructions shall avoid any measurement mistakes, hardware da-
mages etc.

Please feel free to contact us for any questions on the functionality and operation of the instrument. Direct
your questions or requests on spare parts and accessories to the following address:

Address: SINUS Messtechnik GmbH
Föpplstraße 13
04347 Leipzig, Germany

Telephone: +49-(0)341-24429-33
Fax: +49-(0)341-24429-99
E-mail: info@soundbook.de
Web: http://www.soundbook.de
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1 GENERAL INFORMATION AND DESIGN

1 General information and design
Tango_Plus is an integrating sound level meter designed according to IEC 61672-1:2014, accuracy class 1
and immunity to interference group Z. It can measure also 1/1 and 1/3 octaves according to IEC 61260.

NOTICE! Tango_Plus may perform measurements that require an official verification
of the calibration and that are legally binding.
(type approval applied)

ATTENTION! If Tango_Plus is used for legally binding measurements, only original
accessories shall be used.

For performing legally binding measurements with Tango_Plus only the following accessories are admitted
according to the type approval :

• Tango_Plus (907004.2)

• Calibrator Cal200 1/2” type1 PCB (800934.4)

• Calibrator Type 4231 B&K (800043.2)

• Windscreen W2 (800253.0)

Using Tango_Plus the following sound level values may be measured: LAF, LAFmax, LAFmin, LCF, LCFmax, LCFmin, LAS,
LASmax, LASmin, LCpeak, LAeq, LCeq, LCeq-LAeq, LAE, LAFT, LAFTeq, LAFTeq-LAeq, LAImax, LCpeak>n and LAFn. A detailed description
of these values is given in table 1.1 in section 1.6.

NOTICE! The number of the firmware version can be displayed (section 2.2.2).

1.1 Important notes

When measuring with the device, please consider the following notes:

• Use the device as described in this manual only.

• Despite of its robust design, protect the device from any unnecessary bumps and vibrations as well
as humidity and dirt.

• Do not touch or moisten the sensitive microphone membrane during work.

• Pay attention to the permissible temperatures for using the device.

• Always switch off the device after using.

• Do not expose the device to excess temperature as for example in a car with direct sunlight.

• If necessary, clean the device carefully without using solvents.

• Do not disassemble the device. Do not try to repair the device in case of malfuntion. Such manipulation
will always cause the loss of warranty and major damages. Make a note of the occuring errors and
send us the device for repair.
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1.2 Power supply

1.2 Power supply

The device is powered by two batteries of the type LR6A (nominal voltage 1.2 . . . 1.5 V, primary cell or re-
chargeable). Via the according USB cable Tango_Plus can be powered by an external source. For that the
cable has to be connected to a PC or to the public power supply via the provided adapter. The USB access
is totally separated from the internal batteries, so that the batteries are not affected, but accumulators are not
recharged, too. For legally binding measurements Tango_Plus has to be powered by battery, disconnected
from the public power supply.

1.2.1 Replace batteries

The battery compartment is located on the back at the bottom of the device (figure 1.1 bzw. 1.2). Follow the
instructions below to replace the batteries:

• Move up the lock of the battery compartment.

• Remove the lid.

• Remove the discharged batteries.

• Insert the new batteries paying attention to the polarity (figure 1.2)

• Switch on the device and check the battery status on the display (figure 1.3.2).

Figure 1.1: Closed battery compartment Figure 1.2: Open battery compartment
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1 GENERAL INFORMATION AND DESIGN

ATTENTION! Changing the batteries causes loss of time, if Tango_Plus is not connected
to external power supply at the same time.

1.3 Design

Figure 1.3: Design of the device

Tango_Plus contains the following parts:
detachable microphone with preampli-
fier, casing, display, keypad and battery
compartment. Opening the device is
only necessary for replacing the batte-
ries (figure 1.2.1).

At the bottom of the device the USB
socket is located for connecting the
device to a PC (type mini five-pole).
Next to it there is a socket for a 3.5 mm
stereo jack. This monitoring output is
used to connect a headset for example,
it is not approved for legally binding me-
asurements. Furthermore Tango_Plus
provides a socket to connect a printer
directly.

A detailed description of the display and
keypad is given in the paragraphs 1.3.2
and 1.3.1. Pay also attention to the notes
given in paragraph 1.1.

ATTENTION! For legally binding measurements Tango_Plus has to be powered only by
battery. The monitoring output is not approved for this.

1.3.1 Keypad

If the device is not controlled via PC, you may also use the keypad for setup. In the middle it contains arrow
keys with an OK-button in the center. The top corners contain function keys, whose functions are indicated
by symbols on the display. The key below on the left is used to start and pause measurements, while the
one on the right switches on the device and toggles the brightness level.

1.3.2 Display

The display shows the measured values and is used for setting up the device. It is refreshed every 500 ms.
The status bar on the top of the display shows symbols for: Battery, Memory, Play/Pause, Storage, Calibra-
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1.3 Design

tion, USB connection, Level of brightness and time. There are three basic modi to display spectra, history
data or numeric values:

Figure 1.4: Third Octave Display

The Third Octave Display shows a spectrum in
the main part with live values as bars and Leq va-
lues as roof top. Via left/right keys the spectral
cursor can be moved to select signle bands.
The band level and the frequency are displayed
above the graph as well as the measurement du-
ration. On the left LAF and LCF are displayed as
bars. The bottom shows numerically one sound
level value, which can be switched using the
up/down keys.

Figure 1.5: History Display

Instead of a spectrum the History Display shows
two level graphs in the main part. Which
levels are shown is set in the configuration
(section 2.2.2). The time length of the x-axis can
be toggled with the left/right keys.

Figure 1.6: Numeric Display

The Numeric Display shows the value of the le-
vels selected at the bottom.
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1 GENERAL INFORMATION AND DESIGN

1.4 First use

Pay attention to the following notes before using the device for the first time:

• Read carefully the manual and follow the instructions before using the device.

• Insert the batteries as described in section 1.2.1.

• Install the required software on a PC (driver and Tango-Utilities).

• Connect the device with the PC using the supplied USB cable.

• Switch on the device by pressing the On/Off-Button (minimum 3 seconds).

1.5 Software installation

First TANGO driver must be installed for that Tango_Plus is recognized via USB connection. Second Tango-
Utilities should be installed for configuration of Tango_Plus settings and export of data.

1.5.1 Tango_Plus driver installation

Please follow the instructions below to install the TANGO driver on a PC. You find the file on the enclosed
USB stick. Use the Windows Explorer to start the driver installation programme. Perform the install setting
and confirm always. Depending on the system performance this procedure may take a few minutes.

1.5.2 Tango-Utilities installation

Installing the software Tango-Utilities resembles the installation procedure of most Windows applications.
Follow the instructions below:

• Run the installation program (Tango_Utilities_Version.exe).

• The first window shows the software version. Click on Next to continue to the next window.

• Set the installation directory in the next window. Click on Next to continue to the next dialog.

• In this dialog you may specify the directory in the Windows Start Menu. Click on Next to continue to
the next dialog.

• This dialog summarizes your settings. Click on Install to confirm and continue.

• Finish the installation by clicking on Finish .

1.6 Calculated values

Tango_Plus can calculate several sound levels as well as full and 1/3 octaves.
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1.6 Calculated values

1.6.1 Calculated sound levels

Level Description

LAF Sound pressure level, frequency weighting A, Fast (125 ms time constant)

LAFmax Level maximum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data)

LAFmin Level minimum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LCF Sound pressure level, frequency weighting C, Fast (125 ms time constant)

LCFmax Level maximum of LCF for the entire measuring period (on the display) or of the last storing interval (stored data)

LCFmin Level minimum of LCF for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LAS Sound pressure level, frequency weighting A, Slow (1 s time constant)

LASmax Level maximum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data)

LASmin Level minimum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LCpeak Peak value of the C-weighted sound pressure level

LAeq Equivalent continuous sound pressure level for the entire measuring period (on the display) or of the last storing
interval (stored data), frequency weighting A

LCeq Equivalent continuous sound pressure level for the entire measuring period (on the display) or of the last storing
interval (stored data), frequency weighting C

LCeq - LAeq Difference of the values LCeq and LAeq

LAE Sound exposure level, frequency weighting A

LAImax Maximum sound impulse level, frequency weighting A

LAFT Maximum LAF of the last 5 s interval.

LAFTeq Equivalent continuous sound pressure level calculated from the LAFT levels during the entire measuring period
according to DIN 45645-1

LAFTeq - LAeq Difference of the values LAFTeq and LAeq

LCpeak>n Time in which the LCpeak exceeded n dB

LAFn Percentile levels can be calculated from the LAF (n = 1, 2, 3). There are 7 standard percentiles (1, 5, 10, 50, 90,
95, 99), but also user defined percentiles are possible.

Table 1.1: Calculated sound levels

Data can be stored up to an amount of 32 MB.

NOTICE! All sound level values may only be reset by manual Start/Stop operation
and the integration time for the equivalent continuous sound pressure levels
may only be set with this operation.

NOTICE! All integrated sound levels listed in table 1.1 will be displayed on the device
immediately after finishing a measurement/integration.

1.6.2 Calculated spectra

Tango_Plus can calculate full and 1/3 octaves. A, C or Z weigthing may be applied. The frequency range is:
10 Hz - 20 kHz. The storage interval defines the number of individual spectra, that are linear averaged.
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2 APPLIANCE

2 Appliance
2.1 General information

Tango_Plus offers different operating modes:

OFF The device is off and no measurements can be performed. Only the clock is running inside.

Stop The device is running. The LAF and the LCF are measured and displayed. If Record mode is enabled,
the circle symbol is displayed.

Run The device is on and measuring ( is blinking). If data recording has been activated, data will be
stored ( is blinking). You may read the instantaneous measurement values on the display and move
between the values using the Up/Down keys.

Pause A running measurement is paused ( is displayed) and so the measuring time. The measurement
can be stopped or proceeded any time.

Display Description

The device is in Pause-Mode. The measurement has been paused and the measuring time has been stopped.

Data recording is active. The measured data will be stored in Run-Mode.

The device is in Run-Mode (Symbol blinks). The measurement has been started. If data recording is active, the
measured data are stored. If data recording is inactive, no data will be stored.

Table 2.1: Display of run modes

2.2 Device configuration

You may configure the device via PC using the software Tango-Utilities or manually.

2.2.1 Configuration using Tango-Utilities

For configuring the device via PC, you have to install the Tango-Driver and Tango-Utilities software first
(section 1.5). Possible settings in Tango-Utilities are adjusted in the Setup tab. In the column Display
use the check boxes to enable individual values and comboboxes to set the graphic refresh rate for display.
Several values offer optional parameters, which you may set in the column Options. By the buttons Open

and Save you may open a configuration from the PC or save the current one to it. The same can be done
by using the menu points File → "‘Open Configuration"’ and File → "‘Save Configuration As"’. The
current configuration is transmitted to Tango_Plus by clicking on Apply .

In the column Storage the correspondig storage conditions are adjusted. The storage can be turned off,
limited to one finish result or done in regular intervals. For the interval time span several values are provided
from 62,5 ms up to 60 min depending on the measurement value. Even if the interval storage is selected a
finish result over the whole measurement time is calculated and stored additionally. This would always be
saved, even if the intervall storage would have been aborted because of full memory. In this case the record
symbol would stop blinking.

NOTICE! For the interval storage of the percentiles only the same interval time span
can be selected.

If Synchronisation is enabled, the interval storage will be synchronised with the full hours of day time. So
every full hour the current interval is closed and a new one is started. The clock is set every time, when
connecting Tango_Plus to Tango-Utilities.

Manual Tango_Plus 12 of 33 SINUS Messtechnik GmbH



2.3 Tango-Utilities

2.2.2 Manual configuration

The manual configuration of the device without PC is shown in the following table 2.2:

Item Description

Measurement

Record Mode Select values to be stored or just displayed.

Sync at Full Hour Synchronize time intervals to full hours.

Fixed Duration Measurement ends after a fixed time.

Reset Storage File ID Resets File ID to the smallest possible number: Assume stored measurements are labled with
IDs 1 to 6. If for example measurements 3, 5, and 6 are deleted and the File ID is reset, the next
measurement will be labled with the number 5.

Calibration

Start Calibration Start the process of calibration.

Calibration Level Set the calibration level.

Measurement Values (Select a sound level e.g. LAFmax and adjust the following properties.)

Display Location Select on which graph the value shall be shown.

Display Interval Select the rate of display refresh (500 ms, . . . , 60 min, End Result only).

Storage Interval Set the storage interval (No storage, 500 ms, . . . , 60 min, End Result only).

Print Result Decide whether the result shall be printed.

Octave Spectrum

Octave Mode Select whether 1/3 or full octaves shall be measured.

Frequency Weigthing Available weigthings: Z, A, C

Display Range Adjust the scaling of the Y-axis.

Display Interval Select the rate of display refresh (125 ms, . . . , 60 min, End Result only).

Storage Interval Set the storage interval (No storage, 125 ms, . . . , 60 min, End Result only).

Storage Weigthing Available weigthings: Z, A, C

History Graph

Display Range Adjust the scaling of the Y-axis.

History Time Adjust the scaling of the X-axis.

Graph 1 Select which value shall be displayed as yellow.

Graph 2 Select which value shall be displayed as green.

Device

Time Set time and select 12h or 24h format.

Display Set Display properties.

Info Read off version numbers of firmware and hardware.

Print Results

Table 2.2: Manual configuration menu of Tango_Plus

2.3 Tango-Utilities

Tango-Utilities is the basic software to configure Tango_Plus and export values from measurements. It is
not meant to perform further analysis calculations.

2.3.1 Status bar

The status bar displays various status information from left to right:
Connection Status: disconnected, connected, but Tango_Plus off, connected, Tango_Plus on;
Virtual COM Port;
Measurement Status: Stop, Measurement, Pause;
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2 APPLIANCE

Record Status: Record-Mode off, Record-Mode on,
blinken←→ Record-Mode on (Recording);

Marker Status: MARK;
Memory usage: per Hour, Day and Week

2.3.2 Program settings and Extended device settings

Via the main menu Settings->Program. . . the following settings are available (figure 2.1): Selection of the
connected device Tango_Plus (Connected Device), default export directory (Default Export Directory)
and the default directory for configuration data. The Extended device settings cannot be adjusted manually
without PC.

Figure 2.1: Tango-Utilities - Program settings Figure 2.2: Tango-Utilities- Extended device settings

Parameter Description

Disable Device Calibration Select this parameter to disable calibration feature on the device.

Disable display setup changes Select this parameter to lock the display settings.

Disable measurement setup changes Select this parameter to lock measurement recording settings.

Enable fixed record mode Select this parameter to activate the Record-Mode permanently.

Startup after battery replacement Automatic start of Tango_Plus after changing the batteries.
Table 2.3: Extended progam settings

2.3.3 Info Tab

Figure 2.3: Tango-Utilities - Info Tab Figure 2.4: Tango-Utilities - About-Box
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2.3 Tango-Utilities

You may view the software version of Tango-Utilities in the main menu selecting Help -> About (figure 2.4).
The firmware version of the device is displayed in the Info-Tab (figure 2.3).

2.3.4 Setup Tab

The Setup tab of Tango-Utilities (figure 2.5) provides the configuration of Tango_Plus for a measurement.

Figure 2.5: Configuration in setup tab

SINUS Messtechnik GmbH 15 of 33 Manual Tango_Plus



2 APPLIANCE

The first column shows the items, the second the configuration for display, the third for storage and the fourth
for printer. Some items provide special settings, configured in the last column. Changes are to be confirmed
with the Apply button. Setups can be saved and opened using the other buttons.

2.3.5 Display Tab

In the Display tab history values are shown (figure 2.6), which are calculated by the device during a mea-
surement (according to the settings in the Setup-Tab). On the left side you will find a table of values which
are available for display in the graph on the right side. To select a value for graphical display click on the
individual values in the header of the graph. You may select a maximum of four values for simultaneous
display. The context menu of the graph provides Zoom and axes scaling functionality.

Figure 2.6: Show history values in Display Tab

2.3.6 Octave Tab

Figure 2.7: Show spectral values in Octave Tab
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2.3 Tango-Utilities

In the “1/3 Octave” tab spectral values are shown (figure 2.7), which are calculated by the device during a
measurement (according to the settings in the Setup-Tab). To adjust weigthing (Z-blue, A-green, C-yellow)
or refresh rate for graphical display click on the corresponding items in the header of the graph. The context
menu of the graph provides scaling functionality. Also displayed is a coordinate cross. The vertical line
shows the current value of the selected band while the horizontal line shows the sum value.

2.3.7 Data-Tab

On the right side of the Data-Tab (figure 2.8) a table containing the recorded files is displayed. On the left
side a summary of the selected measurement is displayed. By right-clicking on an entry in the table you will
open a context menu in which you may delete the measurement (Delete) or export data (Export).

Figure 2.8: Data Tab
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2 APPLIANCE

2.3.8 Data export

Measured data are saved to the internal storage of the device (32 MB). The data sets are listed in the
Data-Tab (section 2.3.7). By right-clicking you may open a context menu, that provides access to the Export
window (figure 2.9).

History Data tab

This tab provides the export of time histories of level or spectra to the Excel compatible csv format. To use
it, check the “Enable Export file” box. You may specify the name, check automatic attributes to be given to
the export file name and select the values, which that file should contain. Via the Add File button, you can
create more History Data tabs, to get several different configured export files from the same measurement
in the same export process.

Figure 2.9: Export - History Data

Result List tab

Enable this way of export to collect Endresults of all exported measurements in csv format. The configuration
is similar to the History Data tab.
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2.3 Tango-Utilities

Figure 2.10: Export - Result List

Result tab

This tab provides the export only of end results as txt or csv. Just type the filename with the desired format.

Figure 2.11: Export - Result
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2 APPLIANCE

Auditor tab

This tab provides the export of full data as Auditor readable smr format.

Figure 2.12: Export - Auditor

Additional Information tab

This tab allows to put additional information showing up in all export files. Especially a measurement time
can be applied manually using the Set Time button.

Figure 2.13: Export - Additional Information

2.4 Measure

For legally binding measurements the device must run on batteries/rechargeables. Therefore the device
has to be controlled with the keypad (section 1.3.1). Follow the instructions below to perform a binding
measurement:

1. Position the device (held in the hand or mounted upon a tripod).

2. Switch on the device.

3. Check the battery charge status.

4. Use the Record-Button to enable/disable data recording.

5. Press the Start-Button to start the measurement.

6. Press the Stop-Button to stop the measurement.
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2.5 Calibrate

2.4.1 Measure low sound levels

You do not have to make special preparations for measuring low level sounds.

2.4.2 Overload and Underrange

Overload and underrange are displayed, when the linearity range is left. The representation on the display
is explained in the following table 2.4.

Tango-Utilities Display Description

No overload has occured in current measurement.

Overload has occured in current measurement.

Currently an overload occurs.

No underrange has occured in current measurement.

Underrange has occured in current measurement.

Currently an underrange occurs.

Table 2.4: Display of overload and underrange

NOTICE! A reset of the overload or underrange display is only possible by stopping
and restarting the measurement.

2.5 Calibrate

A list of the approved calibrators and the accuracy classes achieved is given in section 5. Follow the in-
structions below to calibrate the device at 1 kHz:

2.5.1 Calibrate using Tango-Utilities

1. Connect Tango_Plus to the PC.

2. Start Tango-Utilities.

3. Insert the microphone into the calibrator and activate the calibration signal. The reference calibration
level is 94 dB for this methode.

4. Press the CAL button in Tango-Utilities. “Calibration activated” appears in the status bar. To cancel
the calibration procedure, press the stop button.

5. Having finished you are asked to adopt the new calibration values. If something went wrong, an error
message appears.

2.5.2 Calibrate Tango_Plus directly

1. Switch on the device.

2. Press the Setup-Button and navigate to the calibration menu.

3. Adjust the calibration level and execute “Start Calibration”. The reference calibration level will be
blinking on the display (e.g. 94 dB). You may adjust this value with the Scroll-Button (94 dB, 104 dB
or 114 dB).

4. Switch on the calibrator (select the correspondig level on the calibrator, if necessary) and insert the
microphone into the calibrator.
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2 APPLIANCE

5. Press the OK-Button and Calibration starts. First, the noise level of the device is measured and second
the calibrator signal. During calibration, is blinking on the display. When stops blinking, the
calibration is finished. The measured level is displayed enabling you to check the calibration result.

6. Press the OK-Button to save the new sensitivity value or press the Setup-Button to reject.

7. You have left the calibration menu and the device is in STOP-Mode.

If the calibration has been affirmed the symbol is shown on the display until the next start of Tango_Plus.

NOTICE! If the new value deviates more than 3 dB from the old one, it is not accep-
ted. The message “Error” is displayed in this case.

Figure 2.14: Calibration menu
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3 Testing information
3.1 Acoustic test

3.1.1 Microphone alignment for measuring according to IEC 61672-1:2014.

To measure the influence of mechanical vibrations you need a second sound level meter with officially verified
calibration as reference device. The microphone of the reference device has to be positioned in a maximum
distance of 0.2 m from the microphone of the tested device and must not be exposed to the mechanical
vibrations of the exciter.

Figure 3.1: Alignment for vibration test

3.2 Electrical test

For eletrical testing use the equivalent electrical impedance device K65 only (section 5) (manufacturer spe-
cifications: 22 pF ±12% with a parallel resistance of 81 MΩ ±12%).

3.2.1 EMC test

The measurement is performed for the following configurations:

Low interference immunity: USB cable linked to public power supply and microphone extension cable
connected

Maximim interference immunity: USB cable and microphone extension cable disconnected

3.2.2 Level linearity

The starting values for the level linearity tests are listed in the last column of table 4.4.
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4 TECHNICAL SPECIFICATIONS

4 Technical specifications

Property Value

Software Tango-Utilities

Number of channels 1

Accuracy Class 1 according to IEC 61672-1:2014

Display of measured values Colour TFT 320 x 240

Frequency weighting A, C (simultaneously), no optional frequency weightings

Time weighting Fast, Slow, Peak (simultaneously), Impulse

Data storage Yes

Self-generated noise ≤19 dB(A)

Max. Sound Pressure Level see table 4.7

Linearity range 25. . . 140 dB(A) (at 1 kHz)

Nominal measuring range for LCpeak 37. . . 140 dB(C)

Max. electr. measuring range ± 2 V

Max. input voltage at
the input of the feeding device

± 2,5 V

Umax at input ± 2,5 V

Integration response immediate

Time weighting F Rise or decay time constant = 0.125 s

Time weighting S Rise or decay time constant = 1 s

Time weighting Peak Rise time constant = 20 µs

Time weighting Impulse Rise time constant = 0.035 s, decay time constant = 1.5 s

Shortest integration time 16 ms

Longest integration time 194 days (100 h running on rechargeables)

Interfaces USB 2.0, serial printer port

Stabilizing time after switch-on 1 min

Warm-up time 1 min

Calibration frequency 1 kHz

Max. time of day drift max. 1.73 s in 24 h

Battery 2 x AA, 40 operation hours

External power supply via USB (see accessories)

Dimensions 266 mm x 76 mm x 38 mm

Weight 320 g (batteries inserted)

Reference conditions

Reference direction Along the microphone axis

Reference sound pressure level 94 dB

Reference frequency 1 kHz

Reference measuring range 25. . . 140 dB(A)

Reference air temperature 23 ◦C

Reference air pressure 101.325 kPa

Reference relative humidity 50 %

Table 4.1: Technical data Tango_Plus
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4.1 Level linearity range

According to IEC 61672-1:2014 Tango_Plus has been tested under the following conditions:

Property value

Frequency range (Free field frequency response) 20 Hz bis 20 kHz

Level range section 4.1

Restriction of linear level range due to mechanical vibration section 4.7.2

Temperature range -10 ◦C bis 50 ◦C

Static air pressure 65 kPa bis 108 kPa

Relative humidity 25 % bis 80 %

Electrostatic discharge section 4.6

High frequency fields section 4.7.1

Mechanical vibration section 4.7.2

Apply signal via equivalent capacitance K65 (Microtech Gefell)

Table 4.2: Test conditions for Tango_Plus

4.1 Level linearity range

The following table 4.3 contains the measurement ranges for A-weighted sound levels and the C-weighted
peak sound level for microphone sensitivity of 50 mV/Pa.

Fast/Slow/Leq in dB(A) LAE in dB(A) LCpeak in dB(C)

25. . . 140 ab 30 37. . . 140

Table 4.3: Level linearity ranges for A-weighted sound levels and C peak

4.2 Linear operating ranges

The operating ranges given below are only valid for calibrated devices! The last columns show the starting
values for the level linearity tests.

f max in dB(A) min in dB(A) Range in dB(A) Starting values in dB(A)

16 Hz 84 25 59 74

31,5 Hz 100 25 75 74

1 kHz 139 25 119 94

4 kHz 140 25 115 94

8 kHz 139 25 114 94

12,5 kHz 135 25 110 94

Table 4.4: Linear operating ranges A-weighted (f is the frequency of the sine signal) and starting values for the level linearity tests.

f max in dB(C) min in dB(C) Range in dB(C) Starting values in dB(C)

16 Hz 126 41 85 74

31,5 Hz 137 42 95 94

1 kHz 139 39 100 94

4 kHz 139 38 101 94

8 kHz 137 39 98 94

12,5 kHz 133 38 95 94

Table 4.5: Linear operating ranges C-weighted (f is the frequency of the sine signal) and starting values for the level linearity tests.
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4.3 Frequency weighting

f A Tango_Plus C Tango_Plus A Standard C Standard Diff A Diff C

10 -67,93 -13,76 -70,00 -14,30 2,07 0,54

12,5 -62,56 -10,84 -63,40 -11,20 0,84 0,36

16 -55,90 -8,12 -56,70 -8,50 0,80 0,38

20 -50,00 -5,94 -50,50 -6,20 0,50 0,26

25 -44,54 -4,20 -44,70 -4,40 0,16 0,20

31,5 -39,36 -2,90 -39,40 -3,00 0,04 0,10

40 -34,36 -1,88 -34,60 -2,00 0,24 0,12

50 -30,14 -1,22 -30,20 -1,30 0,06 0,08

63 -26,12 -0,78 -26,20 -0,80 0,08 0,02

80 -22,32 -0,46 -22,50 -0,50 0,18 0,04

100 -19,06 -0,28 -19,10 -0,30 0,04 0,02

125 -16,12 -0,18 -16,10 -0,20 -0,02 0,02

160 -13,22 -0,10 -13,40 -0,10 0,18 0,00

200 -10,82 -0,06 -10,90 0,00 0,08 -0,06

250 -8,66 -0,04 -8,60 0,00 -0,06 -0,04

315 -6,62 0,00 -6,60 0,00 -0,02 0,00

400 -4,74 0,00 -4,80 0,00 0,06 0,00

f A Tango_Plus C Tango_Plus A Standard C Standard Diff A Diff C

500 -3,22 0,00 -3,20 0,00 -0,02 0,00

630 -1,92 0,00 -1,90 0,00 -0,02 0,00

800 -0,78 0,00 -0,80 0,00 0,02 0,00

1000 0,00 0,00 0,00 0,00 0,00 0,00

1250 0,58 -0,06 0,60 0,00 -0,02 -0,06

1600 0,98 -0,06 1,00 -0,10 -0,02 0,04

2000 1,20 -0,18 1,20 -0,20 0,00 0,02

2500 1,28 -0,28 1,30 -0,30 -0,02 0,02

3150 1,26 -0,40 1,20 -0,50 0,06 0,10

4000 1,10 -0,68 1,00 -0,80 0,10 0,12

5000 0,78 -1,06 0,50 -1,30 0,28 0,24

6300 0,20 -1,64 -0,10 -2,00 0,30 0,36

8000 -0,60 -2,46 -1,10 -3,00 0,50 0,54

10000 -1,74 -3,62 -2,50 -4,40 0,76 0,78

12500 -3,30 -5,14 -4,30 -6,20 1,00 1,06

16000 -5,48 -7,32 -6,60 -8,50 1,12 1,18

20000 -7,90 -9,74 -9,30 -11,20 1,40 1,46

Table 4.6: A- and C-weighted frequency response

Figure 4.1: A-weighted frequency response

Figure 4.2: C-weighted frequency response
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4.4 Microphone

4.4 Microphone

Only the original microphone capsule MK255 by MICROTECH GEFELL is approved for measurements with
Tango_Plus. The directional characteristics of the microphone correspond to the limits specified in IEC
61672-1:2014. The effect of the windscreen on the directional characteristics of the microphone is negligible.
As a result all corresponding correction values are specified with ±0.1 dB. The acoustic center point and
microphone reference point are located at the middle of the microphone membrane.

Property Value

Model Transducer type Capacitive pressure transducer

Polarization backelectret

Frequency range free-field 3.5 Hz . . . 20 kHz (±2 dB)

Sensitivity ca. 50 mV/Pa

Max. SPL for 3 % , distortion at 1 kHz 146 dB

Self-generated noise with preamplifier 15 dBA

Capacitance 17 pF

Operating temperature range -50 . . . +100 ◦C

Ambient temperature coefficient leq0.01 dB/◦C

Ambient pressure coefficient -0.01 dB/kPa

Diameter 1/2”

with protection lid 13,2 ± 0,02 mm

without protection lid 12,7 ± 0,02 mm

Length 16,4 mm

Weight 7,5 g

Thread for preamplifier 11,7 mm 60 UNS

Thread for protection 12,7 mm 60 UNS
Table 4.7: Technical data MK255

4.4.1 Random incidence and free-field correction

f Free field cor. Diffuse field cor.

in Hz in dB in dB

25 0 0

31.5 0 0

40 0 0

50 0 0

63 0 0

80 0 0

100 0 0

125 0 0

160 0 0

200 0 0

250 0 0

315 0 0

400 0 0

500 0 0

630 0 0

f Free field cor. Diffuse field cor.

in Hz in dB in dB

0.8 k 0 0

1 k 0 0

1.25 k -0.03 0

1.6 k 0.03 0

2 k 0.21 -0.1

2.5 k 0.36 -0.1

3.2 k 0.56 0

4 k 0.88 0.1

5 k 1.36 0.2

6.3 k 2.01 0.4

8 k 2.99 0.7

10 k 4.25 0.9

12.5 k 6.14 1.8

16 k 8.77 3.4

20 k 9.9 3.2

Table 4.8: Free-field and random incidence corrections (manufacturer’s specification: measurement uncertainty at 95% certainty ±0.6 dB)
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4.4.2 Directional characteristics

Figure 4.3: Mikrofonachse

4.4.3 Frequency response of the microphone
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4.5 Self-generated noise

The self-generated electrical noise of the device including preamplifier (measured with equivalent capaci-
tance and 50Ω at the input) amounts to approx. 16 dB(A) on the display. The acoustic noise is 16 dB. This
is a total noise level of 19 dB. The highest noise level may be expected when externally powered.

4.5.1 Measurement of low noise levels

For the measurement of low noise levels no special preparation is required.

4.6 Details on EMC

When the device is exposed to electromagnetic emissions the lower limits of the ranges in table 4.3 are
increased by 5 dB. Within these changed ranges the error limits according to IEC 61672-1:2014 are main-
tained. The level linearity range changes to 40. . . 107 dB(A) when the device is exposed to electromagnetic
emissions. There will be no performance loss in the device after electrostatic discharges (touch discharge
up tp 4 kV and air discharge up to 8 kV).

ATTENTION! Legally binding measurements must not be performed, if the device is con-
nected to public power supply.

4.7 Effect of environmental conditions

In order to avoid the effect of sound reflections from the body of the operator interfering with the measure-
ment, Tango_Plus should be located as far as possible from the body. Thus, when actually performing the
measurement, the operator should place himself at a distance behind the tripod-mounted meter, or extend
the hand-held meter as far from the body as is comfortable.

NOTICE! When the temperature changes by more than 15 ◦C an acclimatization time
of 30 min must be safeguarded.
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4.8 Connection assembly of the detachable microphone

4.7.1 Mains frequency and high-frequency fields

Tango_Plus complies with IEC 61672-1:2014 with respect to interference immunity to mains frequency and
high-frequency fields. The interference immunity to mains frequency and high-frequency fields is highest
when the device is running on batteries/rechargeables without USB cable connected.

If Tango_Plus is connected to a PC and measuring high-frequency emissions are highest. Additionally, the
interference immunity to mains frequency and high-frequency fields is lowest in this configuration (alignment
see fig. 4.4). The next lowest emission level is reached in the same configuration, but in STOP-Mode.

In compliance with paragraph 6.6.9 of IEC 61672-1:2014 Tango_Plus is not appropriate to measure levels
lower than 74 dB for an electric field strength exceeding 10 V/m.

Figure 4.4: Alignment measurement HF immunity

4.7.2 Effect of mechanical vibration

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 perpendicular to the mem-
brane plane of the microphone, the lower limit of the linear operating range increases to 75 dB for the
frequencies 31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 parallel to the membrane
plane of the microphone, the lower limit of the linear operating range increases to 58 dB for the frequencies
31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.

4.8 Connection assembly of the detachable microphone

ATTENTION! The detachable microphone must be used only with Tango_Plus! Other-
wise it may be damaged.
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Figure 4.5: Pin assignment for the detachable microphone

The microphone of Tango_Plus is detacha-
ble and connected to the analyser via LEMO
FGG.1B.307. The pin assignment is shown in
figure 4.5.
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5 Accessories
Tango_Plus achieves accuracy class 1 of IEC 61672-1:2014 in all possible device-accessories-alignments
without the necessity of applying any correction values.

Accessory Manufacturer Item number

Cal200 PCB, 1 kHz, 94 dB or 114 dB 800934.4

Type 4231 B&K, 1 kHz, 94 dB bzw. 114 dB 800043.2

Windscreen W2 MICROTECH Gefell 800253.0

USB cable A-Bmini 5 Pol 1.8 m SINUS Messtechnik GmbH 801038.7

USB power supply adaptor SINUS Messtechnik GmbH 601092.6

Equivalent electrical impedance K65 MICROTECH Gefell 800030.3

Table 5.1: Available accessories for Tango_Plus

The Windscreen W2 is black coloured and spherically with a diameter of 69 mm.

5.1 Technical specifications of the calibrators

Feature Value

Standards IEC 60942:2003 and
ANSI S1.40-1984, Class 1

Sound pressure level 94 dB, 114 dB ±0.1 dB

Supported microphone types 1/2”, 1/4”, 3/8”

Weight 156 g

Sound pressure stability <0.1 dB

Surrounding conditions each for ±0.3 dB tolerance

Static pressure 65 kPa . . . 108 kPa

Humidity 10% . . . 90% RH

Temperature -10 ◦C . . . + 50 ◦C

Table 5.2: Technical specifications Cal200

Feature Value

Standard IEC 60942:2003, Klasse 1

Sound pressure level 94 dB, 114 dB ±0.2 dB

Supported microphone types 1”,1/2”

Weight approx. 150 g

Sound pressure stability <0.05 dB

Surrounding conditions

Static pressure 65 kPa . . . 108 kPa

Humidity 10 % . . . 90 %RH

Temperature -10 ◦C . . . + 50 ◦C

Table 5.3: Technical specifications Type 4231
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6 DECLARATION OF CONFORMITY

6 Declaration of Conformity
We, SINUS Messtechnik GmbH, Foepplstrasse 13, 04347 Leipzig, Germany, declare that the product

Sound Level Meter Tango_Plus
Part Number: 907004.2
Serial Number:

to which this CE-declaration relates, is in conformity with the following standards and other documents:

Technical Parameters Sound Level Meter: IEC 61672 or DIN EN 61672-1:2014
DIN EN 45657

Third-octave analyzer: DIN EN 61260:2003 class 1

Electromagnetic Compatibiliy: Emission IEC 61000.6.3 or DIN EN 61000-6-3
IEC 61672 or DIN EN 61672

Immunity IEC 61000.6.2 or DIN EN 61000-6-2
IEC 61326 or DIN EN 61326
IEC 61672 or DIN EN 61672

Safety IEC 61010.1 or DIN EN 61010-1

The measuring system is intended for use with measuring microphones according to IEC 1094-1. This
product has been manufactured and tested in compliance with the following binding internal documentation
from SINUS Messtechnik GmbH:

Manufacturing and Testing documents: - Quality assurance manual
- Manufacturing documents for Tango_Plus
- Testing rules for Tango_Plus

This product was tested and found to comply with all specifications.

Gunther Papsdorf
Managing Director
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